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�CAUTION: Intermec Technologies Corporation suggests you buy cables from us to connect with other
devices.  Our cables are safe, meet FCC rules, and suit our products.  Other cables may not
be tested.  They may cause problems from electrostatic discharge or induced energy.  Our
warranties do not cover loss, injury, or damage from other cables.

�CAUTION: Intermec Technologies Corporation recommends that you only purchase Norand  Mobile
Systems Division certified modems.  Intermec does not certify all modems available in the
marketplace.  Intermec does not warrant noncertified modems; furthermore, these modems
may cause problems from electrostatic discharge and may not conform to FCC regulations.
For a list of Norand Mobile Systems Division certified modems call Customer Support at
1-800-221-9236 in United States or (country code) 800-633-6149 in Canada.

WARNING: The lithium ion battery may explode if replaced incorrectly.  Replace only with the same or
equivalent type.

ADVERTISSEMENT:  La batterie au lithium peut exploser si elle est replacée de manière incorrecte.  Elle ne
doit être remplacée que par une batterie identique ou similaire.

WARNING: Lithium ion batteries may explode or catch fire if overcharged due to improper dock
installation.

ADVERTISSEMENT:  Les batteries au lithium peuvent exploser ou prendre feu si elles sont trop changées à
cause d’une mauvaise installation de la station d’accueil.
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Where to Find Information

This manual describes your device hardware, provides an overview of the programs
included, and describes how to set up communications between your device and
desktop computer and the Internet. The following table is a guide to the different
types of information available to help you use your device. Note that although this
manual introduces the programs on your device, it does not describe them
completely. For more information, see the comprehensive online Help for each
program.

Information Source
Device programs This User Guide

-or-

Online Help on your device. Select Start
and then Help.

Synchronizing and
exchanging files with a
desktop computer

The booklet accompanying the Microsoft®
ActiveSync CD.

-or-

ActiveSync online Help on your desktop
computer. In the ActiveSync window, click
Help, then Microsoft ActiveSync Help.
ActiveSync Help also includes
troubleshooting information on connections.

-or-

Online Help on your device. Tap Start and
then Help.

Toolbar buttons Tap or click and hold on a toolbar button to
see its name. Drag off the toolbar button
before lifting to avoid activating the button.

Up-to-date information on
Windows® CE-based
devices

http://www.microsoft.com/windowsce/

Information on this
release of Windows CE
and ActiveSync

Read Me files (located in the ActiveSync
folder on your desktop computer).
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Chapter 1: Getting Started
a)1 

 What the INTERMEC 6651 can do
 
 The INTERMEC 6651 uses the Microsoft Windows CE operating system, which is
similar to the Microsoft Windows® 95/98 and Windows NT® 4.0 operating systems.
You can use the device to perform many of the PC operations you are already familiar
with, such as accessing e-mail, surfing web pages, writing letters, managing
expenses, and keeping track of appointments and contacts.
 
 The Microsoft Windows CE operating system comes standard with the following
programs:
•  Microsoft Pocket Word
•  Microsoft Pocket Excel
•  Microsoft Pocket PowerPoint®
•  Pocket Internet Explorer
•  Pocket Outlook® (Contacts/Calendar/Tasks/Inbox)
•  Microsoft Pocket Access
•  ActiveSync®
•  Microsoft InkWriter®
etc.
 
 Additional programs from SHARP in this device make your mobile life even more
comfortable.

 Checking the contents
 
 Please check the contents carefully. The package should include the following:

•  Serial cable (PN: 871-012-030)
•  AC adapter (PN:871-012-020)
•  AC power cord (PN:851-036-010)
•  CR2032 lithium backup battery ×2
•  Battery pack (PN:871-012-010)
•  Keyboard hard cover (packed inside the device)
•  Stylus (packed inside the device)(PN:871-012-040)
•  Quick Start Guide
•  Declaration of Conformity

If there are problems with any of these contents, please contact your INTERMEC
TECHNOLOGIES CORPORATION dealer.
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 About this user guide
 
 This user guide helps you get started using the device as soon as possible. It
consists of the following chapters:
 
 Chapter 1 : Getting Started
 Introduces the device and explains how to use this user guide. Quickly walks you
through the device setup procedure.

 Chapter 2 : Hardware
 Explains the hardware features of the device and its general operation.

 Chapter 3 : Basics
 Explains the operation of the keyboad and stylus, and basic operation of Windows
CE.

 Chapter 4 : Microsoft ActiveSync
 Describes ActiveSync.

 Chapter 5 : Microsoft Office Companion Programs
 Describes Pocket Word, Pocket Excel, Pocket Access and Pocket PowerPoint.

 Chapter 6 : Voice Recorder and InkWriter
 Describes Voice Recorder and InkWriter.

 Chapter 7 : Microsoft Pocket Outlook
 Describes Calendar, Contacts, Tasks and Inbox

 Chapter 8 : Getting Connected Remotely
 Explains how to connect the device to a desktop computer, network or the Internet

 Chapter 9 : Bundled Software
 Describes the bundled programs from SHARP.

 Appendices
 Troubleshooting procedures, Specifications and other information about the device.

 This user guide assumes that you are already familiar with Microsoft Windows
95/98 or Windows NT 4.0. If necessary, refer to the appropriate Microsoft
documentation.
 
 

 Conventions used
 
 The following keyboard and symbol conventions are used in this user guide:

 BOLD capitalized notations indicate menu names, commands, toolbar buttons,
tabs in dialog boxes, dialog box titles, and items within display boxes.
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Caring for your device

This device contains sophisticated circuitry and a glass display panel which can be
damaged if not cared for properly. The following precautions should ensure your
device gives you many years of reliable use.

•  Keep your device away from extreme heat. Do not leave it on the
dashboard of a car or near a heater. Do not leave it in any place that is
extremely damp or dusty.

 
 

•  Do not drop your device or subject it to severe impact. Bending the
body can damage the circuitry. Do not use extreme force when
pressing the display or keys.

 
•  Do not use sharp objects or your fingernails to touch the display screen.

We recommend you use only the supplied stylus to tap or write on the
screen.
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•  Hard, sharp objects can scratch your device, so ensure it is closed
and/or protected when carried with other objects.

•  Do not use solvents to clean your device. Use only a soft dry cloth.

•  Since this product is not waterproof, do not use it or store it where
fluids, for example water, can splash onto it. Raindrops, water spray,
juice, coffee, steam, perspiration, etc. may also cause malfunction.

•  Care should be exercised when using this device on heat sensitive
surfaces or your lap as the base will get hot.

 
•  If you force the built-in camera to rotate, you may damage it.
 
•  When opening the display more than 180°, be careful of the following:

•  Do not forcibly rotate the display.
•  Do not rotate the display while cables are connected to the AC

adapter jack, serial port, or modem jack.
Further, make sure that the modem jack is closed.

 
•  Do not leave the device with the PC card or CF card eject buttons

protruding. They might break off.
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 Part names and functions

  

                                 Stylus

                              Hard icon

                          Speaker

                       Security slot    

                   RESET button  RESET

               USB port

            PC Card slot

        PC Card eject button

    Infrared port  I R

    Display

    Cover latch
                    Shutter button

               Microphone

            Built-in camera

       Keyboard

    Keyboard hard cover

14

13

12

16
11

10

9

8

7

6

5

4

3

2

1

15

 Display   Cover latch   Stylus

  Hard icon

 Speaker

 Security slot

 RESET button
Use this button when computer operation freezes.

 USB port

 PC Card slot    PC Card eject button

 Infrared port

 Keyboard

 Built-in camera

 Microphone

 Shutter button

 Keyboard hard cover
It is to be attached when the device is used as a tablet.
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                                        Lock switch

                               Battery pack

               CF card eject button

                      CF card slot

             Earphone jack
                                               Serial/VGA port

                                 Backup battery cover

                          Modem jack

                   Power switch

                   One-touch web surfing switch

                   One-touch mail receipt switch

     FULL RESET button
     FULL RESET

           AC adapter jack

Charging lamp

           Mail lamp

                  One-touch lock switch

16

15

14

13

12

11

1

2

3

4

5

6

7

8

10

9

 FULL RESET button

 AC adapter jack

 Serial port

  Backup battery cover
The backup lithium battery (CR2032) is installed here.

 Modem jack

 Power switch

 One-touch web surfing switch

 One-touch mail receipt switch

 One-touch lock switch

If this switch is in the  position, the one-touch web surfing switch and one-
touch mail receipt switch will not work.

 Mail LED
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 Charging LED
During charging, this LED flashes orange. Once charging is finished, the LED
stops flashing and remains illuminated.

 Earphone jack

 CF card slot    CF card eject button

 Battery pack

 Lock switch
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Setting Up the Device

Important
Before using the device for the first time, please perform all of the procedures
explained in this section.

Installing the Batteries
After the battery pack is installed, the lithium battery for data backup should be
installed.

Installing the battery pack
1. Place the device with the bottom up, and then open the display.

 

 

Note:
The battery pack cannot be installed with the display in the closed condition.

2. Slide the lock switches to the  position.
 

 
 
3. Align the battery pack with the rails of the main device and push it straight in.

 

 
4. Slide the lock switches to the  position.
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 If the lock switches cannot be moved, pull out the battery pack and then insert
it again.

 

 
 
5. Close the display.

Installing the Backup Battery

Caution:
Be sure that you are discharged of static electricity by briefly touching a grounded
metal object before beginning these procedures.

1. Confirm that the battery pack has been installed.
 
2. Remove the screws from the backup battery cover.

 

 
 
3. Insert a finger into the recess and lift up to remove the backup battery

compartment cover.
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4. Install two CR2032 lithium batteries with the plus (+) side up. Press the battery
to the left and press down.

Caution:
Do not touch other parts in the battery compartment.

5. Return the backup battery cover to its original position.
 

 
6. Attach the screws.

 

Charging
1. Confirm that the power to main device is turned OFF (nothing is displayed on

the screen).
 
2. Close the display.
 
3. Connect the AC adapter and the power cord to the main device in the order of

➀ , ➁  and ➂ .

 
 

➀
➃

➁
➂
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4. After a few seconds, charging starts and the orange LED ➃  starts blinking.
 Charging time is approximately 2.5 hours. When charging is completed, the

LED stops blinking but continues to light steadily.
 
5. When charging is completed, disconnect the AC adapter and the power cord.

Note:
•  Charging can be performed while the device is in use.
•  When charging is completed, disconnect the AC adapter and the power

cord.

Caution:
Be sure to disconnect the DC power plug from the 6651 before opening the
display fully, or you could damage the DC power plug or the DC input jack.

Using AC Power Supply
Use the AC adapter to plug your device into external power whenever possible,
especially when:
•  Using a modem card, Ethernet card, or other peripheral.
•  Using the backlight feature of your device display.
•  Connecting to a desktop computer.
•  Letting the LED indicator flash for extended time periods.

1. Confirm that the power to main device is turned OFF (nothing is displayed on
the screen).

 
2. Close the display.
 
3. Connect the AC adapter and the power cord to the main device in the order of

➀ , ➁  and ➂ .

 
 
4. Open the display and turn ON the power.

When you have finished using the unit, disconnect the AC adapter and the
power cord.

Note:
Keep the battery pack attached when AC power supply is used.

➀
➃

➁
➂
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 About power sources
•  Caution: When the main battery is depleted, recharge it promptly. If the depleted

main battery is not recharged, the backup battery will be drained more quickly
than normal. (See Battery life in “Hardware specifications”)

•  The device will turn off if you ignore the low battery warning and continue to work.
If this happens, the data being edited and other information may be lost, and the
alarm may not function correctly.

•  When you use the AC adapter, a slight humming noise may be heard. This is
normal.

•  After charging or prolonged use of the main battery, it may become warm. This is
normal, and does not indicate any problem.

 Caution:
•  The socket outlet must be located near the equipment and be easily accessible.
•  When the AC adapter is not in use, keep it disconnected from a AC outlet.
•  Do not use the AC adapter to operate other equipment, as the equipment may be

damaged.
•  Avoid using the AC adapter during an electrical storm. Electric shock and

damage to the device from lightning is possible.
•  If any fluid which has leaked from the battery enters your eyes rinse them

thoroughly with water and seek medical attention immediately, or serious injury
could results.

WARNING:
THE VOLTAGE APPLIED MUST BE THE SAME AS SPECIFIED ON
THE ADAPTER. USING THE ADAPTER AT A HIGHER THAN
SPECIFIED VOLTAGE IS DANGEROUS AND MAY RESULT IN A
FIRE OR OTHER TYPE OF ACCIDENT, THUS DAMAGING THE
ADAPTER. INTERMEC TECHNOLOGIES CORPORATION TAKES
NO RESPONSIBILITY FOR ANY DAMAGE RESULTING FROM USE
OF THE ADAPTER AT VOLTAGES OTHER THAN THAT
SPECIFIED.
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Removing the Keyboard Hard Cover
1. Open the display.

•  Place your fingers on the tabs to the left and right of the device's central
cover latch, and open the display.

 

 
 
2. Remove the keyboard hard cover.

•  Place your fingers on the left and right tabs (slightly jutting out), then gently
lift up the keyboard hard cover and remove.

 

 

Note:
•  Keep the keyboard hard cover. It is reusable. Attach it when the device is

used as a tablet.
•  Replace the cover the same way you removed it.
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Turning ON the Power
Press the power key (On/Off) to turn on the power.
Keep pressing the power key for about 1 second to turn OFF the power.

 

 

Note:
The power switch can also be used to turn ON the power.
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Chapter 2: Hardware
a)2 

This chapter describes how to use the various hardware features of the device.

Attaching the Keyboard Hard Cover

When using the device as a tablet, attach the keyboard hard cover to avoid
accidentally pressing the keys. Attaching the keyboard hard cover also makes the
device easier to carry.

1. Being careful to place the cover right-side up, align the ▲ marks on the device
with the ▼ marks on the keyboard hard cover.

 

Caution:
Make sure the ▲ and ▼ marks are aligned, and that the tabs on the left and
right of the keyboard hard cover are flush with the keyboard. If you install the
hard cover with the tabs sticking up, you may damage them.

2. Confirm that the marks are aligned properly and gently press the keyboard
hard cover as illustrated in the diagram.
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Using as a Tablet

The display can be flipped over and the device used as a tablet. It is also possible
to reverse the image displayed on the screen.

1. Turn OFF the power.
 
2. Turn the display carefully to transform the device into a tablet.
 

 
 
3. Slide the power switch to turn ON the power.

Keep pressing the power switch to the side for about 1 second to turn OFF the
power.

 

Caution:
•  Before the display is turned, disconnect the AC adapter, modem cable or

serial cable from the rear side of the main device, and leave the cover
closed. Turning the display while the cover is open will result in damage.

•  Be careful not to pinch your fingers when turning the display.

Reversing the Image

Tap the  hard icon.
The screen image is reversed and the keyboard is locked. (The power key is not
locked.)
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Using the Built-in Camera

You can use the built-in camera to capture movies and still images. Since the lens
mount rotates, you can point the lens outward to capture images while holding the
device like a tablet, or point the lens inward to capture images of yourself.

The basic features of the built-in camera are explained here.

Part Names

 

LensRotating lens mount

Shutter button

Note:

If you tap the  hard icon, the screen image is reversed and the keyboard is
locked. (The power key is not locked.) Further, you can change keyboard Lock
settings with Keyboard lock on the control panel.

Basic Features
The method for adjusting the direction of the lens is explained here.

To adjust the direction of the lens
Rotate the lens mount until it points towards the subject, then adjust the direction of
the lens.
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Cautions When Using the Built-in Camera

•  About handling the built-in camera
•  The amount of time it takes for brightness to stabilize differs depending on

the temperature of the surrounding area. Please wait until the brightness
stabilizes.

•  Do not point the lens towards the sun. Color may be lost and an image of
the sun may be burnt into the screen.

•  Important points when recording
•  When using the device in dark places, the display screen will appear grainy,

but this is not a malfunction.
•  When recording moving subjects, the shapes may appear distorted, but this

is not a malfunction.
•  You may see a single frame at a time, but this is not a malfunction.
•  If you point the lens toward a TV picture tube or PC display, you will see

horizontal bands on the screen. Further, you will see horizontal bands on
the recorded image, but this is not a malfunction.

•  The filament of an incandescent light bulb may appear black, especially in
bright areas, but this is not a malfunction.

•  When the scene suddenly moves from a dark subject to a bright subject (or
vice versa), it takes a few seconds for the screen to return to normal.

•  When recording movies, hold the device as steady as possible. If you shake
the device, noise may enter the recording.

•  Condensation
•  When this device is suddenly moved from a cold place to a hot one, water

drops (condensation) form on the inside and outside of the device due to the
difference in temperature. Each situation is different, but leave the device for
approximately 1 hour before using to let it adjust to the surrounding
temperature.

•  Blurring
•  If your hand moves while pressing the shutter during recording, you will

cause the image to blur and the captured photograph may become
disrupted. Make sure you hold the device so that the subject appearing on
the device’s screen does not move during recording.

•  Focusing
•  You do not need to adjust the focus. As long as you are more than 26 cm

(approx. 8.8 in) from the subject, it will be in focus.
•  Subjects that produce infrared rays

•  When recording subjects that produce infrared rays, such as stoves, the
color may not record properly. In this case, recorded images are saved in
the colors they appear on the device’s screen.



2-5

Replacing the Battery Pack

The battery pack is a consumable. When it discharges quickly after charging, the
battery pack is exhausted. Replace it with a new battery pack (PN:871-012-010).

Caution:
•  Make sure you use a battery pack (PN:871-012-010) that is designed for use

with this device. Other battery packs may cause fire or result in data loss.
•  When replacing the battery pack, make sure two backup batteries (for data

backup) are installed. If you remove both the battery pack and the backup
batteries, you will lose all of your data and settings.

1. Confirm that backup batteries are installed and that they are working.
You can confirm the remaining life of the lithium battery (backup batteries) in
Power management on the control panel.

 
2. Turn off the power and wait approximately 3 seconds.
 
3. Open the display slightly, then turn the device upside down.

Note:
You cannot replace the battery pack if the display is closed (locked).

4. Slide the lock switches to the  position.
 

 
 
5. Remove the battery pack from the device.
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6. Align the new battery pack with the rails on the device and insert it, making
sure you keep it straight.

 

 
 

7. Slide the lock switches to the  position. If the lock switches will not move,
reinsert the battery pack.

 

 
 
8. Turn on the power to the device and confirm that it is operating normally.

Replacing the Backup Battery

When the backup batteries for data backup are exhausted and the message
prompting you to replace them is displayed, replace them with two new type
CR2032 lithium batteries. If the low battery warnings for the backup batteries and
the main battery are both displayed at the same time, replace the backup batteries
after you have recharged the battery pack (main battery).

Caution:
•  Make sure you use two type CR2032 lithium batteries. Other types of lithium

batteries may cause fire or harm data.
•  Replace both backup batteries with new ones at the same time.
•  When replacing backup batteries, make sure the battery pack is installed. If you

remove both the battery pack and the backup battery, you will lose all of your
data.

•  Before replacing backup batteries, back up all data to a PC or memory card.
•  In order to discharge static electricity stored in your body, touch a metal object

with your hands before you start to replace the batteries.

1. Confirm that the battery pack is installed and that it is working.
Confirm battery pack (main battery) life in Power management on the control
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panel.
 
2. Turn off the power.
 
3. Remove the screws from the backup battery cover.
 

 
 
4. Place a finger in the groove and remove the backup battery cover.
 

 
 
5. Remove the backup batteries with the tip of a ball pen.

 

Caution:
•  Do not touch any other parts.
•  Do not use any sharp-pointed object to remove the backup batteries.
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6. Place the two new backup batteries (CR2032) with the plus (+) mark in the top
position and insert by pressing on the left side.

 

 
 
7. Replace the backup battery cover.
 

 
 
8. Insert the screws.
 

 
 
9. Turn on the power to the device and confirm that no warnings appear.

Caution:
•  Keep batteries out of the reach of children.
•  Danger of explosion if battery is incorrectly replaced. Replace only with the same

or equivalent type recommended by the manufacturer. Discard used batteries
according to the manufacturer's instructions.

•  Backup battery: Replace battery with Panasonic type CR2032 only. Use of
another battery may present a risk of fire or explosion. See operation manual for
safety instructions.

•  Backup battery: Battery may explode if mistreated. Do not recharge,
disassemble or dispose of in fire.

•  Leaving depleted batteries in the device may result in battery leakage and
damage from corrosion.
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About the Power Source

The device’s power has the following features:
•  When you turn on the power, the screen appears immediately.
•  The power key (On/Off) and power switch perform the same operation.
•  When the power is turned off, it is the same as if the device were in the suspend

mode.
•  If you turn on the power, the last screen displayed before the device was turned

off appears again.
•  If no operations are done for a fixed period of time, the device will automatically

shuts off (goes into the suspend mode).

When turning on the power:

•  Press the power key (On/Off).
•  Press the power switch sideways.

 

When turning the power back on:
After waiting about 3 seconds, press the power key or press the power switch
sideways.
•  When using the one-touch mail receipt and one-touch web surfing switches, wait

3 seconds after turning off the power, then press the button and turn the power
back on.

•  When replacing the battery pack, wait 3 seconds after the power has been
turned off, then slide the lock switch across.

When turning off the power:

•  Press the power key for approximately 1 second.
•  Press the power switch sideways and hold it there for approximately 1 second.
•  Select the Start menu, then select Suspend.

Caution:
Do not turn the power on and off quickly. When a PC card is installed, it takes
approximately 5 seconds for the card to be confirmed.

Automatic power-off (suspend mode)
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Power goes off automatically when:

•  You do not use the keyboard within 1 minute after turning on the power with the
one-touch mail receipt or one-touch web surfing switches, or the remote control.

•  During battery-powered operation, when you do not do any operations within the
time specified in Power management on the control panel (default is 3 minutes).

Setting the device to enter suspend mode

 

Double click on Power management in the control panel. Set the time interval in the
Power off sheet of the Power management properties dialog box.

Resetting the device

Reset
If the device stops responding while you are using it, you can reset the device.
Make sure the device is turned on, and then press the RESET button with the
stylus.

Note:
The reset function will not work if the device is turned off when you press the
RESET button.

 

 

If the problem still persists after you have reset the device, try the following (full
reset) remedy.

Full Reset

Caution:
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The following procedure will cause all data on the device to be lost. Please perform
a full back-up prior to this procedure.

1. Press the RESET button on the side of the device with the tip of the stylus or a
ballpoint pen, and at the same time, press the FULL RESET button on the
bottom of the device in a similar manner.

 

 

2. Turn on and re-setup the device using the H/PC Setup Wizard.

3. Restore your data from a backup.

Note:
•  If you forget your password after restoring a backup, you must set up your device

again, using the above steps, then re-enter your password.
•  We recommend that you back up data to a memory card or PC. If data is backed

up, you can restore the device to its previous state even if you press the FULL
RESET button. For details on backing up data, see Chapter 9, “Backup Tool”
and Chapter 4, “ActiveSync.”
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Connecting the device to your desktop
computer

You can connect the device to your desktop computer to backup data, synchronize
activities, transfer files, etc. by using Microsoft ActiveSync.

Connecting the device to the desktop computer with the
provided serial cable
1. Turn on the device.

2. Flip open the serial port cover as shown.

 

3. Insert the 18-pin end of the supplied serial cable into the serial port on the
device.

 

4. Insert the other end of the cable into the serial port on the desktop computer
that you plan to specify when you install ActiveSync.
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Using the infrared port for file transfer

You can use the built-in infrared port to transfer files (using Windows Explorer) and
communicate with other handheld notebook and desktop PCs compliant with the
IrDA (115.2 kbps) standards.

Make sure both devices are turned on, then take the following steps:

1. Align the two devices so that their infrared ports are facing each other.
 

 

2. From the sending device, tap to select the data of Contacts or the file.

3. On the receiving device, tap Receive from the File menu.

4. On the sending device, tap Send from the File menu, or tap Infrared
Recipient from Send To of the File menu. Start sending the data.
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Using the Built-in Modem

(Model with built-in modem may not available in some countries)

You can use the built-in modem to perform fax and data transmission.

Connect the built-in modem to an analog telephone line as follows:

1. Using your finger, gently open the modem port.
 

2. Insert one end of the modular phone cable into the modem jack.
 

3. Insert the other end of the modular phone cable into a telephone outlet.

Note:
•  Before using the built-in modem for communication, check that it is set up in

Windows CE.
•  When opening the display more than 180°, be sure to close the modem jack.

Leaving it open may damage it.
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Safety Warning on Built-in Modem
•  Never install telephone wiring during a lightning storm.

•  Never install a modular jack in a wet location unless the jack is specifically
designed for wet locations.

•  Never touch uninsulated telephone wires or terminals unless the telephone line
has been disconnected at the network interface.

•  Use caution when installing or modifying telephone cables.

•  Avoid using the modem over a telephone line during an electrical storm.
Electronic shock and main device damage from lightning is possible.

•  This Modem is designed for use with analog telephone systems only. Use with
digital telephone systems, often found in offices and hotels, may cause
permanent damage. You need to be sure the line you are connecting to is an
analog line. Please check with the facilities manager before communicating.

•  Do not use the Modem to report a gas leak in the vicinity of the leak.

Using a PC Card

Caution:
•  Not all PC Cards will work with the device. Be sure to use only recommended PC

Cards. Using non-recommended PC Cards may cause problems such as
damage to the device or the PC Card.
Contact your local dealer for more information on recommended PC Cards.

•  Some PC Cards, such as the Memory Card, consume a great deal of power.
When using such PC Cards, we recommend you use the AC adapter whenever
possible.

•  Depending on the battery level, the display may turn off without displaying any
warning message (such as a low battery warning) when it is used with certain PC
Cards that use a great deal of power, such as the Memory Card.

Inserting a PC Card
Insert the PC Card into the slot as far as it will go. Make sure the PC Card is facing
up. If the card will not go in, check the orientation. Never force the card as it may
cause damage to the device or the card itself.

1. Turn off the device.
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2. Insert the PC Card.

 

3. Swing closed in the PC Card eject button.

Caution:
When using the device as a tablet, the orientation for PC card insertion is the
reverse of that when using the device as a keyboard.

Removing a PC Card
1. Close all applications accessing or otherwise utilizing data on the inserted PC

Card.

2. Turn off the device.

3. Press the EJECT button so that it pops out of the device (➀ ), then push the
button in again (➁ ) to eject the PC card.

 
Note:
Push the EJECT button until you hear it click. If you do not, the EJECT button will
be left protruding from the device.

➁➀
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Using the Compact Flash (CF) Card

Caution:
•  Not all CF Cards will work with the device. Be sure to use only recommended CF

Cards. Using non-recommended CF Cards may cause problems such as
damage to the device or the CF Card.
Contact your local dealer for more information on recommended CF Cards.

•  Some CF Cards, such as the Memory Card, consume a great deal of power.
When using such CF Cards, we recommend you use the AC adapter whenever
possible.

Depending on the battery level, the display may turn off without displaying any
warning message (such as a low battery warning) when it is used with certain CF
Cards that use a great deal of power, such as the Memory Card.

Inserting a CF Card
1. Turn off the device.

2. Insert the CF Card.

 

Caution:
When using the device as a tablet, the orientation for CF card insertion is the
reverse of that when using the device as a keyboard.
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Removing a CF Card
1. Close all applications accessing or otherwise utilizing data on the inserted CF

Card.

2. Turn off the device.

3. Press the Eject button so that it pops out of the computer (➀ ), then push the
button in again (➁ ) to eject the CF card.

 

Note:
Push the EJECT button until you hear it click. If you do not, the EJECT button will
be left protruding from the device.

Connecting to USB Devices

You can connect to USB (Universal Serial Bus) peripheral devices, such as a
mouse, floppy disk drives, printers, and so on.

Note:
•  You can install or remove USB peripheral devices while the device’s power is

turned on.
•  When using USB devices, you must use driver software that is compatible with

the device.

Connecting to USB Devices
1. Open the USB connector  cover.

 

➁➀
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2. Connect the USB device cable to the USB connector.

 

Caution:
Make sure you align the pins on the cable with the pin-holes on the connector.
If you force the cable to connect when it is not aligned properly, you may
damage the cable or the connector.

Note:
•  If a warning appears while you are using a USB device, follow the directions on

the screen.
•  Some devices do not require driver software, such as the mouse.

Removing USB Devices
Remove the USB device cable from the device and close the cover.

Using the Printer

You can communicate with the printer through a USB port, serial port, or built-in
infrared port.

You can print from the following software:
•  Pocket Word
•  Pocket Excel
•  Pocket Access
•  Pocket Outlook (Inbox, Calendar, Contacts, and Tasks)

Note:
•  For details on how to connect the printer to the device, refer to the printer’s

instruction manual.
•  Because print functions for software other than those listed above do not exist,

you cannot print directly from other software.
•  You can use the built-in infrared port to send Image Editor files to printers that

support IrTran-P.
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Printing
As an example, this section explains the procedure for printing Pocket Word data
on a printer connected to a serial port.

1. Start up Pocket Word.
 
2. Select Print from the File menu.

 
 
 The Print dialog box appears.
 
3. Make Printer, Port, and Paper size settings, then tap the OK button.

 

•  When using the serial port, select Port, COM1:9600.
•  When using the built-in infrared port, select Port, IRDA.
•  When using a USB port, select Port, USB.

Printing starts.
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Connecting an External CRT

You can use an optional monitor cable (PN: 871-012-030) to connect the device to
the external CRT (hereafter referred to as CRT) and display the device screen on
the CRT.

Note:
•  CRTs that can be connected with a monitor cable include LCDs (analog interface

connection), projectors and so forth that meet the following conditions.

Mode Horizontal scanning
frequency

Vertical scanning
frequency

800 × 600 dots 37.4KHz 60Hz
800 × 480 dots 37.4KHz 60Hz
640 × 480 dots 30.0KHz 60Hz

•  Input interface: analog RGB, 15-pin (mini D-sub, 15-pin)
•  The CRT displays the same screen as that which appears on the device. If you

connect the cable and turn on the power, it will be displayed at 800 × 600 dots
on the CRT.

•  With Microsoft Pocket PowerPoint, you can display a slide show on the CRT
while operating from the device. Select External display (800 × 600) or External
display (640 × 480) from the Tool menu’s Slide show settings. However, when
the screen is reversed, you cannot display this.

1. Turn off the power to the device and CRT.
 
2. Open the connector cover  .

 

Caution:
Do not open the cover from the bottom. If you force the cover open, you may
damage it.
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3. Insert and fix the cable connected to the CRT firmly into the monitor cable ➀
then connect it to the device ➁ .

 

 
 
4. Turn on the power to the CRT and the device. The screen displayed on the

device is displayed on the CRT.

Note:
If nothing is displayed on the CRT, turn the device off and back on again.

Security Features

To prevent theft, you can connect a retail Kensington Notebook MicroSaver

Security Cable to the security slot  on the device.

 

Caution:
Do not connect the Kensington Notebook MicroSaver Security Cable while any
USB device is connected, as this will damage the USB connector.

➁

➀
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Chapter 3: Basics
a)3 

Entering Information and Selecting Objects

Your device comes with a keyboard, touch screen, and stylus. You use the
keyboard just as you do on your desktop computer. The stylus and touch screen
replace the pointing device (such as a mouse); you select and move objects on the
screen by tapping and dragging them with the stylus. The stylus also allows you to
write on the screen just as you do with a pen and paper.

Tip: If you have difficulty accurately selecting objects with your stylus,
press CTRL+ALT+ + (PLUS key) to calibrate the screen.

Programs

The Windows CE programs that come with your device are stored in ROM (read-
only memory) and cannot be removed or lost. You can install additional programs
that will be placed in RAM (random access memory). The following software is
provided as standard with the Microsoft Windows CE operating system.

Program Description
Calendar Keep track of your appointments and create meeting

requests.
Contacts Keep track of your friends and colleagues.
Inbox Send and receive e-mail.
Tasks Keep track of your tasks.
Microsoft Pocket
Access

View ODBC databases and create Access
information.

Microsoft Pocket Excel View and create Excel documents.
Microsoft Pocket
PowerPoint

Present PowerPoint  presentations.

Microsoft Pocket Word View and create Word documents.
ActiveSync Initiate synchronization with your desktop computer

from your device.
PC Link Initiate a connection with your desktop computer.
Remote Networking Set up connections with other computers or the

Internet.
Terminal View and download files from a bulletin board or send

and receive e-mail.
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Program Description
Microsoft Voice
Recorder

Record your spoken ideas.

Microsoft InkWriter Create handwritten or typed notes and drawings.
World Clock Set the date, time, and alarm for your home city and

the city you are visiting.
Calculator Perform calculations.
Solitaire Entertain yourself while on the road.

Note:
For details on additional software provided by SHARP, see Chapter 9, “Bundled
Software.”

Press the program keys, located along the top of the keyboard, to quickly open or
switch to programs. Holding down the CTRL or SHIFT key while pressing a
program key offers additional functionality.

Program
Key

Program Key
(un-chorded)

SHIFT+Program
Key

CTRL+ Program
Key

Inbox

Launch/switch to
Inbox.

Starts Inbox and
opens a new
message.

Starts Inbox and
opens a new
message.

Internet
Explorer

Switch to next
Explorer window (or
launch if not already
open).

Switch to last
Explorer window (or
launch if not already
open).

Launch new
Explorer window.

Calendar

Launch/switch to
Calendar.

Launch/switch to
Calendar.

Launch/switch to
Calendar.

Contacts

Launch/switch to
Contacts.

Launch/switch to
Contacts.

Launch/switch to
Contacts.

Tasks

Launch/switch to
Tasks.

Launch/switch to
Tasks.

Launch/switch to
Tasks.

Pocket
Word

Switch to next
Pocket Word
window (or launch if
not already open).

Switches to the next
Pocket Word
window (or starts
Pocket Word if it is
not open).

Switches to the next
Pocket Word
window (or starts
Pocket Word if it is
not open).

Program
Key

Program Key
(un-chorded)

SHIFT+Program
Key

CTRL+ Program
Key
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Pocket
Excel

Switch to next
Pocket Excel
window (or launch if
not already open).

Switch to last
Pocket Excel
window (or launch if
not already open).

Launch new Pocket
Excel window.

Pocket
PowerPoint

Switch to next
Pocket PowerPoint
window (or launch if
not already open).

Switch to last
Pocket PowerPoint
window (or launch if
not already open).

Launch new Pocket
PowerPoint window.

Pocket
Access

Switch to next
Pocket Access
window (or launch if
not already open).

Switch to last
Pocket Access
window (or launch if
not already open).

Launch new Pocket
Access window.

Calculator

Start Calculator. Start Calculator. Start Calculator.

World
Clock

Start World Clock. Start World Clock. Start World Clock.

PC Link

Launch PC Link. Launch ActiveSync. Launch Remote
Networking.

Tip: There are many Windows CE programs available, including
freeware and shareware. Visit http://www.microsoft.com/windowsce/
or try searching the Web on the keyword “Windows CE” to find
additional programs for your device.

Other special key functions

•  £ Enters the pound symbol,  + .

•  Enters the Euro symbol,  + .

User 1, User 2 Can be set with the control panel user keys.

Although “User 1” and “User 2” keys appear on the keyboard, by default they do not
input anything. You can set them using User keys in the control panel.
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Using the Start Menu and Taskbar

Use the Start menu to open programs, settings, Help, and recently used
documents. Just select Start, and then select the program or item you want to
open. In addition to the Start menu, the taskbar contains buttons for the programs
you have running, a status area, and a desktop icon.

Tip: You can change the color of the windows and menus. On the Start
menu, select Settings, then Control Panel. Double-tap or double-click
the Display icon, and then select the Appearance tab. Select a preset
scheme or create your own.

Using the Command Bar

Each program has a command bar located at the top of the program window. The
command bar displays both menu names and toolbar buttons. Select the slider to
switch between displaying toolbar buttons only or menu names and toolbar buttons.
You can drag the slider to display the buttons and menu names you want. You can
also drag the slider down to move the toolbar buttons under the menus.
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Finding Files and Exploring the Web

To find files on your device, select Start, Programs, and then Windows Explorer.
When you create and save a file on your device, it is stored in a folder called My
Documents unless you select another location. You can copy or move a file from
one location to another by selecting the file and then using the Copy or Cut and
Paste commands on the Edit menu.

Tip: While using Windows Explorer, you can type a URL in the Address
box to access a Web site if you are connected to the Internet or an
intranet.

To view Web pages, select Start, Programs, and then Internet Explorer. To view
Web pages that are stored on your device, select File, Open, and then the Browse
button and locate the file. To view Web pages on the Internet or an intranet, type a
URL in the Address box. To access Internet or intranet Web pages, you must first
set up a connection between your device and the Internet or an intranet.

Tip: To view the HTML source code of a Web page on your device, first
select Save As on the File menu and save the page on your device.
Then, select Open on the Pocket Word File menu, select All
Documents in the Type list, and select the page you saved.

Customizing Your Device

You can adjust device settings to suit the way you work. Select Start, Settings,
and then Control Panel to see the settings available on your device.

You might want to adjust the following:
•  Owner, to enter contact information in case your device is misplaced.

•  Power, to maximize battery life.

•  System, to adjust memory allocation between storage memory and program
memory.

•  Password, to limit access to your device.

•  Volume & Sounds, to customize or turn off sounds.

•  World Clock, to set the date and time for your location and a second location.
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Chapter 4: Microsoft ActiveSync
a)4 

Microsoft ActiveSync enables you to synchronize the information on your desktop
computer with the information on your device. Synchronization is the process of
comparing the data on your device with your desktop computer and updating both
computers with the most recent information. For example:

•  Keep Pocket Outlook data up-to-date by synchronizing your mobile device with
your choice of Microsoft Outlook, Microsoft Schedule+, or Microsoft Exchange on
your desktop computer.

•  Synchronize Word and Excel documents, Access and other ODBC databases
and tables, and InkWriter documents between your device and desktop
computer. Your files are automatically converted to the correct format.

With ActiveSync, you can also:

•  Back up and restore your device data

•  Add and remove programs on your device.

•  Copy (rather than synchronize) files between your device and your desktop
computer.

For further information, please refer to the Microsoft ActiveSync Help.

http://www.microsoft.com/pocketpc/downloads/activesync.asp

http://www.microsoft.com/pocketpc/downloads/activesync.asp
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Chapter 5:
Microsoft Office Companion Programs

a)5 
The Microsoft Office companion programs consist of Microsoft Pocket Word,
Microsoft Pocket Excel, Microsoft Pocket Access, and Microsoft Pocket
PowerPoint. These programs work with the Windows versions of the same
programs on your desktop computer to give you easy access to up-to-date copies
of your documents. You can create or edit Excel and Word files, PowerPoint
presentation notes, and Access databases and tables on your device. Word and
Excel templates are available to help you quickly create documents. Once you
have created or edited a document, synchronize it with your desktop computer to
copy the new document, or changes you’ve made to the existing document, to your
desktop computer. For more information on synchronization, see ActiveSync Help
on the desktop computer.

You can access the Office companion programs by selecting Start, Programs,
Office, and then the program you want to open.

Tip: More information on the procedures described in this chapter, as
well as information on additional procedures, can be found in online
Help on the device. Select Start, Help, and then the program you want
information on. Because programs work in similar ways to their
counterparts on the desktop computer, online Help covers basic
procedures and the differences between the companion programs and
desktop programs. If you need more information on using an Office
program, see the documentation that came with the desktop version of
the program.

Pocket Word: Creating Documents

You can use Pocket Word to create documents, such as letters, meeting minutes,
and trip reports. You can also use Pocket Word to open and edit documents
created in the desktop version of Word. When you are ready to save a document
you created or edited, you can save it in a variety of formats, including Pocket
Word (.pwd) and Word (.doc). If you plan to send the document through e-mail to
someone who will be using Word, not Pocket Word, be sure to save it in the Word
(.doc) format.

To type text in Pocket Word, tap or click the screen to place the insertion point and
start typing. Use the spelling checker to verify accuracy. You can quickly format the
text, using buttons and menu commands. You can format as you go or apply
formatting later.
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You can type text in either Outline view or Normal view, and you can easily switch
from one view to the other, using the View menu. Work in Outline view when taking
notes in meetings; use headings to highlight the main points and body text to add
details.

To take meeting minutes using Pocket Word:
1. Select File, New, and then Document from Template.
 
2. Select Meeting Notes and then OK.
 
3. Select File and then Save.
 
4. Enter a name, choose a storage location, and then select OK.
 
5. Replace the text in the template.

Tip: To see more of your document, select Full Screen on the View
menu.
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Pocket Excel: Creating Workbooks

You can use Pocket Excel to create workbooks, such as expense reports and
mileage logs. You can also use Pocket Excel to open and edit workbooks created
in the desktop version of Excel. When you are ready to save a workbook you
created or edited, you can save it in a variety of formats, including Pocket Excel
(.pxl) and Excel (.xls). If you plan to send the document through e-mail to someone
who will be using Excel, not Pocket Excel, be sure to save it in the Excel (.xls)
format.

Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions,
sorting, and filtering. You can split panes to easily view different areas of a large
worksheet. You can also “freeze” the top and leftmost panes in a worksheet to
keep row and column labels or other data visible as you scroll through a sheet.
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To log travel expenses using Pocket Excel:
1. Select File, New, and then Workbook from Template.
 
2. Select Expense Report and then OK.
 
3. Select File and then Save.
 
4. Enter a name, choose a storage location, and then select OK.
 
5. Replace the text in the template.

Tip: If your workbook contains sensitive information, you can protect it
with a password. To do so, open the workbook, select File, and then
Password. Every time you open the workbook, you will need to enter
the password, so pick one that is easy for you to remember but hard for
others to guess. Workbooks with password protection cannot be
synchronized.

Pocket Access: Viewing and Creating Data

Use Pocket Access to view and update data derived from Microsoft Access,
Microsoft SQL Server, and other ODBC databases you have created on the
desktop computer. Simply create the database on your desktop computer and then
transfer the data to your device. For example, a sales organization might use
Access on the desktop computer to create a master database of products and
order forms. The sales force can synchronize their devices with the master
database to get up-to-date product information and to upload completed client
order information. For more information on synchronizing, see ActiveSync Help on
the desktop computer.

You can also use Pocket Access to create new databases, tables, and SQL
procedures directly on your device.

Tip: Programmers can use Microsoft ActiveX® Data Objects for
Windows CE (ADOCE) and Microsoft Visual Basic® or Microsoft Visual
C++® to develop custom database solutions. For more information, see
http://www.microsoft.com/windowsce/.
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To create a new database and table on the device:
1. Select Start, Programs, Office, and then Microsoft Pocket Access. If

Access is already running, select File and then Open/New Database. If you
do not see this command on the menu, select View and then Database View.

 
2. Enter a name for the database and select OK.
 
3. Double-tap or double-click the Create a new table icon.
 
4. In the Field Name box, enter a name.
 
5. From the Data Type list, select a data type. A field's data type cannot be

changed after the table is saved.

•  Text boxes have a size limit of 255 characters. To enter longer notes, select
the Memo data type.

•  To enter numbers with decimal points, select the Float data type.
•  To enter numbers between -32,768 and +32,767, select the Integer data

type.
•  To enter smaller numbers, select the Small Integer data type.
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6. To set the size limit of a field, enter an amount in the Field Size box. A field's
size cannot be changed after the table is saved.

 
7. To index the field, select Yes from the Indexed list. Indexing a field allows

Pocket Access to find and sort information faster for that field.
 
8. Repeat these steps until you have created all the fields you want for your table.
 
9. Select File and then Save Table.

Tip: If you have tables that you don’t want to keep updated on the
device (such as product catalogs), mark them as read-only when
transferring them from the desktop to the device to save time during
future synchronization sessions. ActiveSync will not check for updates
the next time you synchronize.

Pocket PowerPoint: Showing Presentations

Use Pocket PowerPoint to quickly and easily deliver a professional presentation on
your device (for one-on-one presentations) or connect your device to a VGA
monitor and show the presentation to a larger group (this require an optional
monitor cable). Simply create the presentation in Microsoft PowerPoint on your
desktop computer and then transfer the presentation to your device. Your Pocket
PowerPoint file will include the text, pictures, notes, and layout position of the
original Microsoft PowerPoint presentation, but will not include animations or slide
transitions.

To show a presentation:
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1. Using ActiveSync, copy the presentation from your desktop computer to your
device. For more information, see ActiveSync Help on the desktop computer.

 
2. Select Start, Programs, Office, and then Micosoft Pocket PowerPoint.
 
3. In the Open Presentation dialog box, select the presentation you want to

show, and then OK.
 
4. To change the presentation display and slide advance options, select Tools

and then Set Up Show.
 
5. To start the show, select View and then View Show. If you chose Manual in

step 4, use the Previous and Next buttons to control the slides.

Tip: You can tailor a presentation while on the road by adding a new
title slide to your presentation. To do so, select Tools and then Title
Slide.
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Chapter 6:
Voice Recorder and InkWriter

a)6 
Voice Recorder and InkWriter are programs for quickly capturing your ideas, notes,
and thoughts. With Voice Recorder, you can record reminders and ideas. With
InkWriter, you can take handwritten and typed notes and create drawings.

More information on the procedures described in this chapter, as well
as information on additional procedures, can be found in online Help on
the device. Select Start, Help, and then the program you want
information on.

Voice Recorder: Capturing Ideas and Thoughts

Quickly capture thought, reminders, ideas, and phone numbers with Voice
Recorder.
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To record and play a recording:
1. Select Start, Programs, Accessories, and then Microsoft Voice Recorder.
 
2. Hold your mobile device’s microphone near your mouth or other source of

sound.
 
3. Select the Record button. You’ll hear a beep when recording begins.
 
4. To stop recording, select the Stop button. The new recording appears in the

recording list.
 
5. To play a recording, double-tap or double-click it in the recording list. To pause

playback, select the Play/Pause button. Select Play/Pause again to resume
playback.

Tip: You can play all of your recordings, one after another. Select the
recording you want to play first, select Control and then Play
Sequential. The selected recording and following recordings will be
played. A short beep will sound between recordings.
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InkWriter: Creating Notes and Drawings

InkWriter, a text, graphics, and ink processor with Rich Ink technology, makes it
easy to write and draw the way you do on paper, but with the benefit of being able
to edit and format what you've written and drawn. With InkWriter, you can enter
information in the way that's easiest for you. You can type using the keyboard, or
you can write and draw directly on the screen using your stylus or pointing device.
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To create an InkWriter document:
1. Select Start, Programs, Accessories, and then InkWriter.
 
2. Create your document:

•  To write, select View and then Writing and use the stylus like a pen. If you
are using a pointing device, click and drag to write on the screen.

•  To type, select View and then Typimg and use the keyboard.
•  To draw, select View and then Drawing and use the stylus like a pen. If you

are using a pointing device, click and drag to draw on the screen. You can
also create a drawing in Writing view by crossing three of the ruled lines on
the first stroke of the drawing.

 
3. When you are finished, select File and then Save.

Tip: InkWriter can help you draw perfect circles, rectangles, triangles,
and lines. In Drawing view, draw the shape you want and use the
Select tool to select it. Then, select Format, Shapes, and select the
shape you want.
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Chapter 7:
Microsoft Pocket Outlook

a)7 
The Microsoft Pocket Outlook program includes Calendar, Contacts, Tasks, and
Inbox. Using ActiveSync, you can synchronize information in Microsoft Outlook ,
Microsoft Schedule+, or Microsoft Exchange on your desktop computer with your
device. Each time you synchronize, ActiveSync compares the changes you made
on your device and desktop computer and updates both computers. For more
information, see ActiveSync Help on the desktop computer.

Calendar, Contacts, and Tasks each consists of a card view and list view. The card
view is where you enter or view the details for each entry. The list view is where
you view all entries. With Inbox, you can send and receive e-mail messages, either
through synchronization with Outlook or Exchange on your desktop computer or by
connecting directly to your mail server through an Internet or network account.

You can access Pocket Outlook by selecting Start, Programs, Pocket Outlook,
and then the tool you are interested in.

More information on the procedures described in this chapter, as well
as information on additional procedures, can be found in online Help on
the device. Select Start, Help, and then the program you want
information on.
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Calendar: Scheduling Meetings and
Appointments

Use Calendar to schedule appointments, meetings, and other events. You can
check your appointments in one of several views (Day, Week, Month, Year, and
Agenda) and easily switch among the views by selecting the corresponding toolbar
button.

 



7-3

To create a new appointment:
1. From any view, select the New Appointment button.
 

 

2. Enter a description and a location.
 
3. Select the time and date.
 
4. To add notes, select the Notes button, and then select the notes area. Enter

your notes.
 
5. To assign the appointment to a category, select the Categories button and

select a category from the list.
 
6. Select other desired options and then OK when finished.

Tip: To quickly add an appointment in Day or Week view, select the
time and type the description and location. Enter the location in
parentheses if you want Calendar to recognize it as the location. For
example, “Lunch (Cafeteria).”
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If you need to schedule a meeting with people who use Outlook, Pocket Outlook, or
Schedule+, you can use Calendar to schedule the meeting. When attendees
receive a meeting request, they can choose to accept or decline the meeting. If
they accept, the meeting is automatically added to their schedule. In addition, their
response is automatically sent back to you, and your calendar is updated.

Before you can send a meeting request, you will need to enter e-mail addresses in
Contacts and set up Inbox to send and receive messages. For information on using
Contacts and Inbox, see “Contacts: Tracking Friends and Colleagues” and “Inbox:
Sending and Receiving E-mail Messages.”

To create a meeting request:
1. Select Tools, Options, and then choose a mail transport. If you send and

receive messages using synchronization, select ActiveSync. If you connect to
an ISP or network, select the service you set up in Inbox.

 
2. Select File and then Make Meeting.
 
3. Enter the meeting information.
 
4. Select the contacts you want to invite.
 
5. Select other desired options and then OK.

Inbox automatically creates a meeting request and sends it to the attendees the
next time you connect to your mail server or synchronize with your desktop
computer.

Tip: Your device will remind you about your appointments and
meetings by sounding an alarm, flashing the notification light, or
displaying a message on the screen. To change how your are notified,
select Tools and then Options. Select the Alarm button and then
Reminder Options.
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Contacts: Tracking Business Colleagues

Contacts maintains a list of your business colleagues so that you can easily find
the information you’re looking for, whether you’re at home or on the road. Using the
device IR port, you can also quickly share Contacts information with other Windows
CE-based mobile device users.

To create a new contact:
1. Select the New Contact button.

2. Enter a name.
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3. Select the Business or Personal button and enter information in the

appropriate fields. Supply an e-mail address if you want to send meeting
requests and e-mail messages to this contact.

 
4. To add a note or assign the contact to a category, select the

Notes/Categories button. Then select the notes area and enter your notes, or
select a category from the list.

Tip: You can send up to 25 contact cards at a time to another Windows
CE-based device. In the Contacts list, select the item(s) you want to
send, then File, and then Send. If you are receiving items(s), select
File and then Receive.

Tasks: Keeping a To Do List

Use Tasks to keep track of what you have to do. Overdue tasks are displayed in
bold and in red.
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To create a new task:
1. Select the New Task button.
 

 
 

2. Enter a description.
 
3. Select the start date, due date, and other information.
 
4. To add notes, select the Notes button and then the notes area. Enter your

notes.
 
5. To assign the task to a category, select the Categories button and select a

category from the list.
 
6. Select other desired options and then OK.

Tip: To mark a task as complete, in the task list, select the check box in
the Status column. To delete all completed tasks, select Edit and then
Delete Completed Tasks.
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Inbox: Sending and Receiving E-mail Messages

Use Inbox to send and receive e-mail messages. You can access your e-mail by
connecting to a mail server through an Internet or network account or by
synchronizing with your desktop computer.

 



7-9

Connecting to a mail server
You can send and receive messages by connecting directly to your mail server.
Use a modem to connect to your Internet service provider (ISP), or use a modem
or Ethernet card to connect to the local area network that your mail server is
connected to. In addition to creating a connection to your ISP or network, you must
give Inbox the information it needs to communicate with your mail server.

Tip: Inbox does not currently support connecting with proprietary mail
protocols such as AOL and MSN . However, you can still gain access
to the Internet through these services. There may be third-party
programs available that would enable you to send and receive mail
through proprietary protocols. Try searching the Web on the keyword
“Windows CE” to find third-party programs for your device.

Setting up Inbox for connecting to a mail server
1. Get the following information from your ISP or network administrator: POP3 or

IMAP4 server name, SMTP host name, user name, password, and domain
name (for network connections only).

 
2. Select Start, Programs, Pocket Outlook, and then Inbox.
 
3. Select Services and then Options.
 
4. On the Services tab, select Add.
 
5. Choose IMAP4 Mail or POP3 Mail, enter a name for the connection, and then

select OK.
 
6. In the Mail Service Definition dialog box, enter the information from step 1. In

Connection, choose the remote connection you want to use. (If you are
receiving e-mail through a network connection, Select Network Connection.)
If you have not created a connection, select Create new connection, double-
tap or double-click the Make New Connection icon, and follow the instructions
in the wizard. When finished, select Inbox in the Taskbar and continue setting
up Inbox. For more information, see “Chapter 7: Getting Connected Remotely.”

 
7. In the Mail General Preferences dialog box, select desired options.
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8. In the Mail Inbox Preferences dialog box, select desired options.

•  In When Getting Messages, choose how you want messages downloaded
by default. Choosing Get full copy of messages will take up more storage
space on your device. Choosing Only synchronize Inbox folder hierarchy
(IMAP4 only) will speed up the time it takes to download your messages.

•  In When Getting Full Copy, choose whether you want to download file
attachments and meeting requests when you get full copies of messages.
This setting applies whether you have chosen to download full copies of
messages by default, or if you selectively download full copies of messages
by opening the message and selecting the Get Full Copy button. In
addition, if you want to receive meeting requests, your Exchange Server
administrator must enable support for Rich Text Format for your account.
Ask your administrator if this feature is enabled for you.

Downloading messages

To send and receive e-mail, select the Services menu and make sure that the
service you want to use is selected (the selected service has a bullet next to it.)
Then, select the Connect button. When you connect to the mail server, the
messages on your device and mail server are synchronized: new messages are
downloaded to the device Inbox folder, messages in the device Outbox folder are
sent, and messages that have been deleted on the server are removed from the
device Inbox.  These folders are stored under the service you created when setting
up Inbox. Double-tap or double-click a message in the message list to open it. If
you read a message and decide that you need the full copy, select the Get Full
Copy button.
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Disconnecting from the server

To disconnect Inbox from your mail server, select the Connect button again. You
also need to disconnect your dial-up connection by double-tapping or double-
clicking the icon in the status bar and selecting Disconnect.

Managing messages and folders
By default, messages are displayed in one of four folders in the service you
created: Inbox, Deleted (local), Outbox, and Sent. The Deleted (local) folder
contains messages that have been deleted on the device. If you are using IMAP4,
you may see a Deleted Items folder. This folder is for deleted messages on the
server. The behavior of the Deleted and Sent folders depends on the Inbox options
you have chosen.
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If you want to organize messages into additional folders, select File, Folder, and
then New Folder. Then, drag messages into the folder you created. The behavior
of the folders you create depends on whether you are using POP3 or IMAP4.

If you are using POP3, when you drag messages to a folder you created, the link is
broken between the messages and their copies on the mail server. The next time
you connect, the mail server will see that the messages are missing from the
device Inbox and delete them from the server. This prevents you from having
duplicate copies of a message, but it also means that you will no longer have
access to the messages you move to the folders you create from anywhere except
the device.

If you are using IMAP4, the folders you create and the messages you move are
mirrored on the server. For example, if you move two messages from the Inbox
folder to a folder called Family, the server will create a copy of the Family folder
and copy the messages into that folder. Therefore, messages are available to you
anytime you connect to your mail server, whether it is from your device, laptop
computer, or desktop computer. This synchronization of folders occurs when you
create a new folder, move messages into a folder, exit the Inbox program, or select
Synchronize Folders on the Services menu. If you want to view the messages in
a folder while disconnected from your mail server, select the folder and then
Offline Folder on the Services menu.

Synchronizing E-mail Using ActiveSync
Another way to access your e-mail is by synchronizing your device and desktop
computer. Using ActiveSync on your desktop computer, you can send and receive
e-mail messages by exchanging information between Inbox on your device and
Inbox in either Outlook or Exchange on your desktop computer. When you
synchronize, any changes made on either computer are transferred to the other. If
you have received new messages in Inbox on your desktop computer, the
messages are copied to your device. If you delete a message on the device, it is
deleted from the desktop the next time you synchronize. If you compose and send
new e-mail messages on your device, the messages are moved to the desktop
computer and sent the next time you synchronize. In addition, changes you’ve
made to Calendar, Contacts, and Tasks are updated.

If you are receiving e-mail by synchronizing with your desktop computer, the device
Inbox is set up by default. However, because e-mail messages are not
synchronized by default, you will need to set up ActiveSync on your desktop
computer to include e-mail messages when synchronizing.

For specific instructions on setting up and using synchronization, see ActiveSync
Help on the desktop computer.
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Downloading messages
To send and receive e-mail, connect to your desktop computer and initiate
synchronization. The way you initiate synchronization depends on how you are
connected to your desktop computer and the settings you have chosen in
ActiveSync. For more information, see ActiveSync Help on the desktop computer.

When you synchronize, new messages in Inbox on the desktop computer are
copied to the Inbox folder on your device, and messages in the device Outbox
folder are sent. These folders are stored under the ActiveSync service in Inbox.
Double-tap or double-click a message in the message list to open it.

Managing messages and folders
Messages are stored in one of four folders in the ActiveSync service: Inbox,
Deleted (local), Outbox, and Sent. The behavior of the Deleted and Sent folders
depends on the Inbox options you have chosen.

If you want to store messages in a folder other than Inbox, select File, Folder, and
then New Folder. Create the folder and then drag messages into it. Doing so
breaks the link between these messages and their copies on the desktop
computer. When you synchronize next, the messages in the folder you created will
not be synchronized. In addition, the desktop computer will see that the messages
are missing from the device Inbox folder and delete them from the Inbox folder on
the desktop so that both Inbox folders match. This prevents you from getting
duplicate copies of a message, but it also means that you will no longer have
access to the messages you move out of Inbox except from the device.
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Sending a message
To send a message:

1. Select Compose and then New Message.

 
 

2. Select the To field and enter the address of one or more recipients, or select
the Address Book button to select addresses from the Contacts list or an
address service.

 
3. Select the Subject field and enter a title for the message.
 
4. Select the message body and type your message.
 
5. To attach a file, select the Add Attachment button.
 
6. Select the Send button.

If you are not connected to your mail server, the message is moved to the Outbox
folder and will be sent the next time you connect or synchronize.
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Chapter 8:
Getting Connected Remotely

a)8 
If you want to use your device to connect to your desktop computer, a network, or
the Internet while away from your office, you must create a dial-up connection. This
is called remote networking. You have the following remote networking options:

•  Connect to your Internet service provider (ISP). Once connected, you can send
and receive e-mail messages and view Web pages. If this is the method you
want to use, see “Connecting to an ISP.”

•  Connect to the network at your company or organization. Once connected, you
can send and receive e-mail messages, view intranet Web pages, and access
files on the network. If this is the method you want to use, see “Connecting to
Your Network.”

•  Connect to your desktop computer to synchronize remotely. Once connected,
you can synchronize information such as your Pocket Outlook data. If this is the
method you want to use, see “Connecting to Your Desktop Computer to
Synchronize Remotely.” For more information on synchronization, see
ActiveSync Help on the desktop computer.

Note:
•  Chapter 9, “Simple Internet Connection,” provides an easy alternative to the

procedures explained in “Connecting to an ISP” and “Connecting to Your
Network.”

•  Settings must be made using the Simple Internet Connection procedure before
using the Mail, Web surfing, and FTP Internet applications provided by SHARP,
or the one-touch mail receipt and web surfing switches.

Connecting to an ISP

You can connect to your ISP by creating a dial-up connection. Once connected,
you can send and receive e-mail messages and view Web pages.

To create a dial-up connection to an ISP:
1. If your device does not have a built-in modem, install a modem card.
 
2. Get the following information from your ISP: ISP dial-up access telephone

number, user name, and password.
 
3. Select Start, Programs, Communications, and then Remote Networking.
4. Double-tap or double-click the Make New Connection icon.
 
5. Enter a name for the connection, such as “ISP Dial-Up,” select Dial-Up
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Connection, and then select Next.
 
6. Select your modem type.
 
7. You should not need to change any settings in the Configure or TCP/IP

Settings dialog boxes. Most ISPs now use server-assigned addresses. If the
ISP you are connecting to does not use server-assigned addresses, enter the
addresses in the TCP/IP Settings dialog box. When finished, select Next.

 
8. Enter the access phone number and select Finish.
 
Once you have created the dial-up connection, you simply double-tap or double-
click the connection, enter your user name and password, and select Connect any
time you want to connect. Once connected, you can use Pocket Internet Explorer to
visit Web pages or Inbox to send and receive e-mail. Before you can use Inbox,
you need to provide the information it needs to communicate with the mail server.
For specific instructions, see “Inbox: Sending and Receiving E-mail Messages”.

Connecting to Your Network

If you have access to a network, you can send e-mail, access file servers, view
intranet pages, and possibly access the Internet. You can connect to your network
in one of two ways:

•  Create a dial-up connection using a RAS account. Before you can create this
dial-up connection, your network administrator will need to set up a RAS account
for you. If this is the method you want to use, see “To create a dial-up connection
to a network.”

•  Use an Ethernet card and a net tap to connect to the network. If this is the
method you want to use, see “To create a network (Ethernet) connection.”

To create a dial-up connection to a network:
1. If your device does not have a built-in modem, install a modem card.
 
2. Get the following information from your network administrator: corporate dial-

up access telephone number, user name, password, and domain name.
 
3. Select Start, Programs, Communications, and then Remote Networking.
 
4. Double-tap or double-click the Make New Connection icon.
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5. Enter a name for the connection, such as “Corporate Dial-Up,” select Dial-Up
Connection, and then select Next.

 
6. Select your modem type. You should not need to change settings in the

Configure or TCP/IP Settings dialog boxes. When finished, select Next.
 
7. Enter the access phone number and select Finish.

Once you have created the dial-up connection, you simply double-tap or double-
click the connection, enter your user name, password, and domain, and select
Connect any time you want to connect. Once connected, you can use Pocket
Internet Explorer to visit intranet Web pages and Inbox to send and receive e-mail.
Before you can use Inbox, you need to provide the information it needs to
communicate with the mail server. For specific instructions, see “Inbox: Sending
and Receiving E-mail Messages”.

To create a network (Ethernet) connection:
You do not need to create a new connection in Remote Networking on your device
for a network connection. Instead, you must install and configure an Ethernet card.
The drivers for the card already exist on your device.

1. Insert the Ethernet card into your device and connect it to your network cable.
You must have an NE2000-compatible Ethernet card.

 
2. You may see a message warning about battery power. If you have an A/C

Adaptor, plug it into your device.
 
3. In the Settings dialog box, enter the information for your server. See your

network administrator if you need assistance. Most networks use DHCP, so
you should not have to change these settings. If the Settings dialog box is not
displayed automatically, go to Start, Settings, Control Panel, and double-tap
or double-click Network. Select your Ethernet driver and select Properties.

 
4. Select Start, Settings, Control Panel, and double-tap or double-click

Network. In the Identification tab, enter your name, password, and domain.

Once connected, you can use Pocket Internet Explorer to visit intranet Web pages
and Inbox to send and receive e-mail. Before you can use Inbox, you need to
provide the information it needs to communicate with the mail server. For specific
instructions, see “Inbox: Sending and Receiving E-mail Messages”.
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Getting Help on Connecting Remotely

More information on the procedures described here, as well as information on
additional procedures, can be found in the following locations:

•  “Inbox: Sending and Receiving E-mail Messages”.

•  ActiveSync Help on your desktop computer.

•  Online Help on the device. Select Start, Help, and then Inbox, Remote
Connections, or Synchronization.
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Chapter 9: Bundled Software
a)9 

Your device comes with preinstalled software applications from SHARP.

Simple Internet Connection

Simple Internet Connection is software for making connections necessary for
Internet connection and e-mail, or switching the connection to the Internet. You can
register multiple Internet connections and mail addresses, allowing you to use the
software both at work and at home.
This section explains how to connect to your Internet service provider and how to
connect to the Internet via a LAN network.

Settings must be made using the Simple Internet Connection procedure before
using the Internet applications provided by SHARP (Mail, Web surfing, and FTP),
or the mail receipt and web surfing switches.

Connecting to your Provider
Make sure that you have instructions and materials supplied by your Internet
service provider available, and refer to these while making the settings.

Note:
Setting required by some providers may not be possible with the device using
Simple Internet Connection or Remote Network. Also, no software is provided for
special protocols such as those used by MSN or AOL.

Register your provider into connection
This section describes how to register a new connection. You do not have to be
connected to a phone line to make this setting, so you please take your time.

1. Double tap the Simple Internet Connection icon.

 
The Simple Internet Connection Dialog box appears.
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2. Tap the New button.
 

 

3. Select Telephone line, and tap the Next button.
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4. Select the connection method, and tap the Next button.
 

 
 

•  Select Regular Phone Line (Tone) or Regular Phone Line (Pulse) for
connection to a regular phone line.

•  When connecting via an extension that requires a 0 to be dialed first, check
Add prefix and enter 0 to the edit box.

5. Set each of the items and tap the Next button.

 

In this dialog box, settings are made for connecting to your provider.
The items displayed vary according to your provider. Refer to the instructions
supplied by your provider when making the settings.
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6. Set each of the items and tap the Next button.

 

In this dialog box, settings are made for e-mail.
The items displayed vary according to your provider. Refer to the instructions
supplied by your provider when making the settings.

7. Check the contents of the settings, then tap the Register button.

 

The provider is registered into Select Connection in initial dialog shown at
step 2.
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Editing connection settings
You can make changes to connection settings, or create a new connection from an
existing connection setting.

1. Select the connection to be edited, and tap the Copy button or the Edit button.

 

•  When you want to create a new connection using the edited contents of an
existing connection, tap the Copy button. This is useful when the same
connection uses more than one connection method.

•  When you want to change only the connection settings, tap the Edit button.

2. Tap the Next Button.
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3. Select the connection method, then tap the Next button.
 

 
 
4. Edit items as necessary in the Internet Settings or Mail Settings dialog boxes

that follow, then tap the Next button.
 
5. When the Verify Settings dialog box appears, check the contents of the

edited settings and tap the Register button.
If you selected Copy in step 1, a new connection is registered into the Select
Connection list.

Switching connections

1. Select a registered provider, and tap the Switch Connection button.
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2. Tap the OK button.

 

Connection will be made to this connection until you switch to a different
connection.

Connection via a LAN
Before making settings, you will need to get information such as IP addresses from
your network administrator. Make the settings as instructed by your network
administrator.

Note:
To connect to the Internet via a LAN, you will need a LAN (network) card.

Important:
•  Please use a LAN card whose operation has been confirmed by SHARP. Using

other LAN cards may damage the device or the card.
•  To make a connection to the Internet via a LAN, some knowledge of networks is

required. If a mistake is made when making a setting, not only will connection
not be possible but damage to the entire LAN network could result. Make
settings as instructed by your network administrator.

Registering a LAN Connection
1. Install a LAN card into the device, and make LAN card settings.
 
2. Double tap the Simple Internet Connection icon.

The Simple Internet Connection dialog box is displayed.
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3. Tap the New button.
 

 

4. Tap LAN and then tap the Next button.
 

 
 
5. Set each of the items as necessary and tap the Next button.
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6. Set each of the items as necessary and tap the Next button.
 

 
 
7. Set each of the items as necessary and tap the Next button.
 

 
 
8. Check the contents of the settings and then tap the Register button.

 

The new connection is registered into Select Connection.

Switching the connection to LAN
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1. Select a registered connection, and tap the Switch Connection button.

 

 The Simple Internet Connection dialog box appears.
 
2. Tap the OK button.
 

 
 
3. Remove the LAN card from the device once, and then re-install it.
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9 

Mail

Sending Message
First, perform a test by sending a message to yourself. This is useful for checking
to see how an addressee will view your mail.

1. Double tap the Mail icon.

 
If the E-mail: Inquiry dialog box appears, tap Yes.

 

Mail starts.

2. Tap the  button.

 

A screen for composing a message appears.



9-12

3. Input your e-mail addresses.

 

Tap the New button, input the e-mail address into the address dialog box that
appears, and then tap the OK button.
The e-mail address is input into Address.

4. Write the message.

 

Input a title for the message into Subject.
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5. Tap the  button.
 

 
 
6. The message that you create is stored in the Outbox folder.
 

 
 
7. Select Send Message from the Tool menu.

 

The connection is opened.
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A message is displayed informing you that the message has been sent, then
the connection is cut.

 

Viewing Received Mail
Let’s see if the message you sent to yourself has arrived.

1. Select Receive Message from the Tool menu.

 

Note:

With the  or by selecting Send/Receive Message from the Tool menu, you
can send and receive message with one operation.

The connection is opened.
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A message is displayed informing you that the e-mail has been received, then
the connection is cut.

 

2. Tap the in tray, then tap the  button to display the contents of the message.

 

Is the message displayed as you expected?
Before sending a message to your friends, send some to yourself for practice.
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Note:

•  When you want to reply to a message, tap the  button to enable you to
add text to the original message. This is the same as selecting Reply to
Sender from the Compose menu.

 

 
 
•  To delete a message, tap on the message you wish to delete and then

select delete from the Edit menu. The message is moved to the Delete
Items. Selecting Empty Deleted Items from the File menu erases all
messages in the Delete Items.
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Sending a message with a file attached
Let’s send an e-mail with an attachment consisting of an image recorded using an
MPEG-4 camera.
You can also write a message after choosing the file to be attached with the Movie
Gallery or PC File Viewer.

1. Create a message, and tap Attachment sheet.

 

The Attachment sheet is displayed.

2. Tap the Attach button.
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3. Specify the location of the file to be attached, then tap the OK button.

 

The file is attached to the message.

4. Send the message in the normal way.
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Viewing Attached Files

A message that has a file attached to it is displayed with a mark. When you
double tap the attached file, the appropriate software for viewing the file starts
automatically, and you can view the attached file.

 

Sending a message to Multiple Addresses
By including many addresses in a message’s address box, you can send a single
message to multiple locations.
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Filtering Messages in the Inbox
Received message in the inbox can be filtered into specified folders according to
conditions that you can set. In this way you can easily filter mailing list messages,
mail news and so on.

Setting the conditions for filtering
1. Tap the cabinet under which you want to create a folder for storing filtered

messages, and select New Folder from the File Menu.

 

Give the new folder a name that is easy to understand.

2. Select Filtering Options from the Compose menu, then tap the Add button in
the Filtering Options dialog box that appears.

 

The Filtering Rules dialog box appears.
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3. Set the conditions for filtering, and tap the OK button.

 

The Filtering Options dialog box is displayed and the conditions are added to
the list.

4. Tap the OK button

 

Filtering Messages

When you select Filtering Message from the Compose Menu, the message in the
Inbox is filtered according to the conditions that you set.
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Using an Address Registered in Contact
When you register an e-mail address in Contact, you can also use it with Mail.

 

When you select the Address Book on the left of the screen, the E-mail Address
dialog box appears. You can enter e-mail addresses into the To:, Cc:, and Bcc:
boxes by double tapping on e-mail addresses in the list, then tapping the OK
button.

Receiving a message by One-Touch
Even if the device is not turned on, you can receive mail with a single operation by
using the One-Touch mail receipt switch. When the device is connected to a phone
line or mobile phone and you push the one touch switch, the connection is opened
automatically, a message is received and the connection automatically cut when
receiving is complete.

 

Note:
•  When using the one-touch mail receipt switch, place a checkmark next to Save

Password in Simple Internet Connection.
•  The green lamp lights while the connection is being made, then flashes while a

message is being received. The lamp goes out when there is no further message
to receive.

•  Push the One-Touch lock switch  to prevent the One-Touch mail receipt switch
from being pressed by accident.
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9 

Web Surfing

The “Web Surfing” software allows automatic gathering of information as the
software automatically patrols home pages that you have registered in advance.
Operations from connecting to the Internet, patrolling the home pages, to
disconnecting the line are performed automatically. Captured home pages can then
be viewed at leisure whenever convenient.
Using the One-Touch web surfing switch, gathering of information can be
conducted by a one-touch operation without even opening the display or turning on
the power.

Note:
•  The unit must be set up so that connection to the Internet is enabled, and the

Save Password option must be enabled in Simple Internet Connection. For
details on the setting method, refer to “Simple Internet Connection” in these
instructions.

•  Depending on the home page contents, there are pages from which information
cannot be captured.

Preparations for Web Surfing
To prepare for web surfing, the home pages to be patrolled should be registered.

1. Choose the START button and then choose PROGRAMS. Select SHARP
Applications, followed by Web Surfing.
“Web Surfing” is launched.

2. Tap the Input URL button.
Up to 10 home pages can be registered.

 

•  Tapping the Select From Favorites button displays the Select From
Favorites dialog box. The home page(s) can now be selected from those
stored in Favorites.
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•  You can change the destination folder.
•  When switching the destination folder, you may not be able to display

previously collected results. If this occurs, open index.html in the collection
results folder.

The Web page dialog box appears

3. Enter the URL, and tap the Add button.
•  When capturing information from home pages using frames, check the

Load Links option. In this case, only the top page of the specified URL is
captured.

 

The specified home page is added to the list.

 

To Edit the Settings of a Registered Home Page

Choosing the home page that you want to edit and tapping the Edit button,
displays the Web Page dialog box to enable editing of settings.
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To Delete a Registered Home Page

Delete a home page by selecting the home page and then tapping the Remove
button.

Automatic Capture of Information
There are two methods to execute automatic capture of information: using the
“Web Surfing” method or using the One-touch web surfing switch.

Using the “Web Surfing” Method
1. Launch “Web Surfing”.
 
2. Tap the Start Surfing button.

 

Connection to the Internet is established and information capture starts. When the
capture of information is completed, the connection is terminated. The results of
the auto surfing can be viewed by tapping the Show Download Page button.

 

The links to the captured information are stored with the file name Surfing Data in
the Web Surfing subfolder of the My Documents folder.
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Using the One-Touch web surfing switch
Even without turning on the device web surfing can be executed with a one-touch
operation by using the One-touch web surfing switch.
When the unit is connected to a phone line or a cellular phone and the One-touch
web surfing switch is pressed, connection is automatically established and capture
of information commences. When gathering of information is completed, the power
is turned off automatically.

 

To view the captured home pages, launch the Web Surfing application and tap the
Show Download Page button.
•  The green lamp lights while the unit is connected to the Internet. It goes out

when gathering of information is completed and the connection is terminated.
•  If you turn the power on after the One-touch web surfing switch is pressed, the

dialog box showing the results of the web surfing appears.

•  Placing the One-touch web surfing switch at the locked  position prevents the
One-touch web surfing switch from being pressed unintentionally.

Note:
The One-touch web surfing switch can be used even if a password is set for the
unit.
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To View Captured Home Pages
1. Double-tap the Web Surfing icon.

The Web Surfing application is launched.
 
2. Tap the Show Download Page button.

The results of the web surfing are shown.
 
3. Tap the URL of the home page that you want to view.

 

The captured home page is displayed.

 

Note:
•  If the Don’t Load Images option was enabled, images are not displayed.
•  When a new web surfing is conducted, the information captured the

previous time is deleted
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9 

MPEG-4 Camera

This software allows you to record a 1-minute video, with sound, using the internal
camera in the device. Recorded images and audio can be attached to e-mail and
sent.

Limitations

•  Windows cannot be moved or iconized.
•  When a window is inactive, image is paused. However, if recording is in

progress, recording continues even while the window is inactive.
•  The Suspend Mode (in which the device is powered down) is disabled while

recording or saving images.
•  The screen is not dimmed during recording even if power reduction settings are

made in ‘back light’ in the Control Panel.
•  If the software is shut down or the power is turned off during recording, the

recording will be canceled.
•  Although other software running concurrently may obscure your view of the

image, camera operation is not affected.

Preparing for Recording
This section explains how to prepare for recording using the device in tablet
configuration. When using the keyboard configuration, please refer to ‘Recording’
later in this manual.

1. Attach the keyboard hard cover.
Attaching the keyboard hard cover makes the device easier to carry.

 

2. Tap the  icon to reverse screen display.
Screen display reverses and the keyboard locks.
You can also lock the keyboard with Keyboard Lock in the Control Panel.

3. Make sure that the modem jack and serial connector cover are closed.

Caution:
Damage will result if the display is rotated without closing the modem jack and
serial connector cover.

4. Gently turn rotate the display to put the device into tablet configuration.
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Recording
Caution:
Before recording something important, first make a trial recording to confirm that
recordings are saved properly.

1. Double tap the MPEG-4 Camera icon.

 
MPEG-4 Camera starts.

2. Tap the  button, and specify movie or still image.
When in Movie Record mode, the button changes to  to display the
recording time.

 

3. While watching the image on screen, point the internal camera at the subject
and rotate the lens.

 
4. Press the shutter button on the device.

This is the same as tapping the  button on the device.
The image is recorded.
•  When recording a movie, press the shutter button to start recording, then

press it again to stop recording.
•  When recording a still image, the image is recorded when you press the

shutter button.
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Specifying Record/Save conditions
Tap the  button, to display the settings screen.
Set the items as necessary.

 

Viewing a recorded image
Tap  to start the Movie Gallery and show the entire recorded movie.

Note:
With the Movie Gallery, recorded images can be listed and controlled in thumbnail
format.
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9 

Movie Gallery

Movie Gallery is software for listing and controlling images from thumbnails.

Things you can do with Movie Gallery:
•  Display files and folders as thumbnails.
•  Move files and folders.
•  Delete files and folders.
•  Display information about files and folders.
•  Change file names.
•  Search for files.

Files that can be displayed in thumbnail format:
•  ASF
•  JPEG (Some formats cannot be displayed, such as progressive JPEG)
•  GIF
•  BMP (24BPP, 16BPP, 8BPP)
In some cases, the above formats may not be displayable.

Using the Movie Gallery
The following example shows how to play movies recorded with the internal
camera.

Note:
When copying movie files into the device, copy them to \My Document\Movie
Gallery.

1. Double tap the Movie Gallery icon.

 
The Movie Gallery starts.
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2. Double tap the file you want to see.

 

The Movie Player starts and the file is played automatically.

•  When you tap the  button after tapping a file, you can delete the file.

•  When you tap the  button after tapping a file, you can display information
about the file.

•  Tap the  button to search for a file. You can use Wildcard (*) when
searching for files. For example, if you are searching for asf files, input *.asf.

•  Tap the  button to start Mail and attach the file you select.
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9 

Movie Player

The Movie Player is software for playing MPEG-4 movies (audio, visual) recorded
using the device’s internal camera.

Note:
•  Refer to Help for information about limitations when playing and displaying

images.
•  Movie Player can only play movie files recorded in MPEG-4 format using the

unit’s internal camera.

Playing Movie Files
1. Double Tap the Movie Player icon.

 
The Movie Player starts.

2. Tap the  button and select the movie file.
The movie file starts playing automatically.
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•  Tap the  button to start play. Tapping this during play will pause the
movie.

•  Tap the  button to stop the movie.

•  Tap the  button to play the movie repeatedly.

•  Tap the  button to change the display size to 320×240 dots. This
results in a coarser appearance.

•  Tap the  button to mute the sound.

•  Tap the  button to reduce the possibility of frames dropping out when
playing high resolution movie files (S-Fine, 1/4 VGA). This results in some
increase in the time required for loading the first file.

•  Tap the  button to save a still image (JPEG or BMP) from the image
being displayed.

•  Tap the  button to display information about the movie file.
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PC File Viewer

PC File Viewer enables you to see the contents of desktop PC files in several
different formats without actually having or opening the applications used to create
files in those formats. To start PC File Viewer, double-tap the PC File Viewer icon
on the desktop, or tap the Start button and select Programs, SHARP
Applications, and then PC File Viewer.

 

 

➀ File List button. Hides (and redisplays) the file directory on the left side
of the screen.

➁ Properties button. Shows the properties of the selected file.

 

➀ ➁ ➂ ➃

➆

➄

➅
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➂ Copy button. Copies the area currently selected in the PC File Viewer
screen into the clipboard, from which it can be pasted into another
application.

➃ Starts up related applications

➄ Attaches the selected file to mail

➅ Separator bar. Drag it right or left to change the width of the file directory.

➆ Context menu. Appears when you tap the file contents while holding down the
 key.

Opening a File for Viewing
Double-tap the file name in the file list, or select Open Another File for Viewing
from the File menu, select the file to view from the Open dialog box, and tap the

 button.

Using Files
Using PC File Viewer, you can copy viewed files, copy data from viewed files into
another application, and search for text within viewed files.

Copying Data into Another Application
1. In PC File Viewer, select the portion of the file to be copied by dragging across

the desired area. (To select the entire file, tap Select All in the Edit menu.)
 
2. Copy the selected area into the clipboard by tapping the Copy button, or by

tapping Copy in the Edit menu or context menu.
 
3. Start up the target application, position the cursor as desired, and paste the

contents of the clipboard.
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Searching for Text in Viewed Files
1. Open the document or spreadsheet containing the text to be found.
 
2. Tap Find in the Edit menu.
 
3. When the Find dialog box appears, enter the text to be found.
 
4. Tap the Find button. The found text is displayed in reverse video.

Note:
To search for other occurrences of the text, select Find Previous or Find Next in
the Edit menu.

Customizing PC File Viewer
Tap Options in the View to display the PC File Viewer Options dialog box. By
checking the appropriate checkboxes and selecting appropriate values in the
various list boxes, you can:

•  Set the default font that is used for displaying the contents of viewed files in text
data.

•  Determine how PC File Viewer behaves upon viewing a file of unknown type.

•  Show or hide gridlines in viewed spreadsheets.

•  Show or hide gridlines in viewed databases.

•  Select the data format used for copying data into the clipboard.

•  Select the default font to be assigned to data copied into the clipboard.

•  Choose whether to include or exclude field names when copying data from a
database.
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Display Limitations of PC File Viewer
PC File Viewer is capable of displaying data produced by a wide variety of
applications. However, it does not fully replicate the functions of these applications,
and in some cases, the appearance of displayed data will differ from that produced
by the applications themselves. For example, PC File Viewer may use its own
display format for producing data layouts, formats, lines, and symbols.

Also, PC File Viewer is not capable of reproducing displays that result from special
character settings or formatting.

Some further display restrictions are imposed by limitations of the Windows CE
operating system.
•  Since OLE is not fully supported, data such as images and graphs embedded in

text or data will not be properly displayed.

•  Since Pocket Word does not provide a table function, table frames and data
layouts resulting from copying and pasting of tables cannot be properly
displayed.

Here are some examples of application data that cannot be properly displayed.
Databases

•  With dBase, objects whose data type is binary, memo, or OLE will be
displayed as the labels “(Binary Data)”, “(Memo File)”, or “(OLE Field)”, rather
than as objects.

•  PC File Viewer displays line numbers, column numbers, and field names
using its own standard format. For example, if the line numbers in the original
data are 3, 4, 7, and 8, PC File Viewer will display them as 1, 2, 3 and 4. Field
names are not displayed.

•  PC File Viewer does not support display of Paradox table files (.db files).

•  PC File Viewer does not support all of the numeric data types of Access.

•  Data that has been imported into Access by attachment may not be
displayed.

Documents

•  Headers and footers may not be displayed properly.

•  Footnote symbols and roman numerals are displayed as arabic numbers.

•  Depending on document size, a blank page may be displayed at the
beginning of documents.

Graphics

•  JPEG files encoded with progressive encoding are not supported.

Spread sheets

•  All Excel 97 sheet names become “Sheet 1,” “Sheet 2,” and so forth.

•  The date may not be displayed in the specified display format.
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Image Editor

Image Editor enables you to edit image files. With Image Editor, you can edit image
files, add hand-written notes, convert file formats, run a mini slide show, and much
more. Sizes of files you can open and edit can be up to 800 × 600 dots.

To start Image Editor, double-tap the Image Editor icon on the desktop, or tap the
Start button and select Programs, SHARP Applications, and then Image Editor.

 

➀ Switches to view mode for viewing the current file.

➁ Switches to edit mode for editing the current file.

➂ Image editing tools.

➃ Commands available for the active editing tool.

➀ ➁

➂ ➃
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Editing images
1. Tap New on the File menu to create a new file, or tap Open to select an

existing file and tap the Edit icon (  ) to switch to edit mode.

2. Use the image editing tools to edit the image.

3. Tap  to save the image.

Note:
•  You can open JPEG, BMP, 2BP and GIF files, but you can only save to the

JPEG, BMP or 2BP file formats. If you edit a GIF file, you must save it to the
JPEG or BMP file format.

•  You may not be able to open a file if there is not enough program memory. Try
increasing the program memory.

•  About JPEG format:
As compared to BMP format, JPEG format is very small. This is possible
because the JPEG format discards some details of the original image. This also
means a JPEG file may not look exactly like the original image. If you would like
to save an image with full detail, use BMP format.

•  About Decrease Color Depth and Reduce Size:
When you use the Reduce Size function of Image Editor, you will not be able to
use the Decrease Color Depth function until the image is saved.
Similarly, when you use the Decrease Color Depth function of Image Editor, you
will not be able to use the Reduce Size function until the image is saved.
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Image Editing tools

                           Stamp (adds any of 64 “stamps” to an image)

                    Ellipse with fill (draws ellipses with fill)

             Ellipse (draws ellipses)

      Rectangle with fill (draws rectangular shapes with fill)

Rectangle (draws rectangular shapes)

                           Eraser (erases unwanted part of an image)

                     Line tool 2 (draws straight lines)

               Line tool 1 (draws lines at 45 degree increments)

              Pen tool (allows freehand drawing)

        Text (adds text to the image)

Area selector (selects an area for further manipulation)

Decreasing color depth of image
While in View mode, you can reduce the number of colors in an image. Full color
can be reduced to 256 colors, 256 grays, 4 grays, or black/white; 256 colors can be
reduced to 4 grays or black/white; and 4 grays can be reduced to black/white.

Reducing size of image
From View mode, you can reduce the size of an image to 75%, 50% or 25% of the
original. Each dimension (width/height) of the image will be reduced by the selected
amount.
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Running a mini slide show
You can use Image Editor to run a mini slide show, as follows:

(Simulated image)

1. Gather all image files for the slide show into a folder.

2. If necessary, rename the files so that, when alphabetically sorted, they are
arranged in the correct order for the slide show.  For example, you can name
the first slide Slide01.bmp, the second one Slide02.bmp, etc.

3. In Image Editor, open the first file in View mode.

4. From the Image menu, tap Slide Show.

5. Press the down key and the second file will be displayed. To move back to the
previous file, use the up key. To cancel the slide show, press the Esc key.

 When no more files can be shown, a message appears to indicate there are no
more files for viewing.



9-43

Auto Image Correction
Auto Image Correction automatically optimizes the contrast, brightness, and
saturation of the displayed image for best appearance.

To use Auto Image Correction, while in View mode tap Auto Image Correction in
the Image menu. Correction starts and the cursor changes to an hourglass icon.
After correction is completed, a message appears.

Tap , then either save or discard the corrected image.

Note:
•  After using Auto Image Correction to optimize an image, menu functions such as

Decrease Color Depth and Make Movie are disabled until the changes have
been saved or discarded. To discard the changes, tap the  button and

then tap  in the dialog box that appears.
•  This feature does not always improve the result. Depending on the image data,

the image may appear worse than when this feature is not used.
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Backup Tool

The “Backup Tool” can be used to back up the unit’s data and settings to a memory
card.
“Backup” is the process of storing a duplicate of the data or settings of this unit on
a commercially available memory card (PC card, CF card). “Restoring” is the
process of returning backup data to its original location.
To prepare for unforeseen situations, it is recommended that you regularly back up
data from the unit to a memory card, etc. If you retain a backup copy of data, you
will always be able to restore the device to the state it was in when the backup copy
of the data was made, even in the case when a full reset operation has been
performed.

Note:
•  It is also possible to back up the data on a PC.
•  The password set using Password on the Control Panel cannot be backed up.

Caution:
•  Use a memory card type whose operation has been verified by Sharp. Using

other types of memory cards could result in damage to the main unit and/or the
memory card.

•  Do not operate the unit while backup or restoring is in progress. This could
prevent correct backup or restoring.

•  Always use the AC adapter when using a memory card for backup or restoring.

To Back Up
Note:
•  To back up the data and settings of the main unit, a memory card with a free

storage space of 28 MB is required. However, the required free storage space
differs with the amount of data.

•  When the “Backup Tool” is launched, the free storage space is indicated
automatically.

1. Close all software running on the main unit.
 
2. If not already connected, connect the AC adapter to the main unit.
 
3. Attach a memory card to the main unit.
 
4. Choose the START button followed by PROGRAMS. Then choose SHARP

Applications and select “Backup Tool”.
The Backup Tool dialog box appears, and the empty storage space of the
memory card is indicated together with other information.

 
5. Choose the memory card to serve as the backup destination, and then tap the

Create Backup Data button.
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Note:
If a file with backup data already resides on the memory card, the Create
Backup Data button will not be selectable. In this case, first tap the Delete
Backup Data button to delete the old backup file, and then make a new
backup.

The confirmation dialog box appears.

6. Tap the Yes button.

 

Backup is carried out. When the backup is complete, the completion message
appears.

 
7. Tap the OK button.
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To restore
1. Close all software running on the main unit.
 
2. If not already connected, connect the AC adapter to the main unit.
 
3. Attach the memory card with the backup data to the main unit.
 
4. Choose the START button followed by PROGRAMS. Then choose SHARP

Applications and select Backup Tool.
The Backup Tool dialog box appears, and the empty storage space of the
memory card is indicated together with other information.

 
5. Choose the memory card with the backup data, and then tap the Restore

Backup Data button.

 

Note:
If the Delete Backup Data button is tapped, the backup data is deleted from
the memory card.

The confirmation dialog box appears.

6. Tap the Yes button.

 

The backup data is restored. When the restoring process is completed, the
completion message appears.
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7. Tap the OK button.

 

8. Press the reset button on the side of the main unit.
 
9. Check the date and time using the “World Clock” option on the Control Panel.

If incorrect date and time are shown, correct the settings.
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9 

Launcher

By registering files and applications that you use regularly with the Launcher, you
can open files or start applications simply by tapping their icons.

Opening from the Launcher

1. Tap the  hard icon.
The Launcher dialog box appears.

 
2. Tap the icon.

Launcher Registration
1. Tap Edit in the Launcher dialog box.
 

 
 
2. Select the location that you want to register (box) and tap the Set button.
 
3. Select the file that you want to register, then tap the OK button.

An icon is added for the file that you selected.

Note:
When making a registering a hard icon as user-defined, first delete the icon,
then register it.
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Appendices
A 

A. Troubleshooting

If you encounter difficulties while using your device, look here. If you need
troubleshooting information for ActiveSync, see ActiveSync Help on your desktop
computer or visit Microsoft's web site at:
http://www.microsoft.com/pocketpc/support.asp

Remote Connections
This section covers situations you may encounter when trying to connect your
device to other sources of information. For problems with communicating with your
desktop, see ActiveSync Help on your desktop computer.

Problem Solution
Can’t dial out with the device
modem

•  Verify that the modular phone cable is
firmly connected to your device and
the telephone jack.

•  Make sure the telephone line is
analog. (Analog telephone lines
transmit data in analog instead of
digital form. Your home telephone line
is most likely analog, while office
telephone lines are often digital.)

•  Make sure you’ve correctly set dialing
properties for this connection.

•  Make sure the modem is waiting for a
dial tone. Select Start, Programs,
Communication, and then Remote
Networking. Tap or click your
connection once to select it, and then
select Properties on the File menu. In
the Dial-Up Connection dialog box,
select the Configure button and then
select the Call Options tab. Select
Wait for dial tone before dialing.

•  For international calls, allow more time
for the call to go through. On the Call
Options tab described in the previous
bullet, clear the Cancel the call if not
connected within option or increase
the number of seconds allowed.

http://www.microsoft.com/pocketpc/support.asp
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Problem Solution
Can dial out but can’t make a
proper connection

•  Make sure the network to which you
are trying to connect supports Point-
to-Point Protocol (PPP). PPTP
connections are not currently
supported. Your Internet service
provider or network administrator can
verify this.

•  Verify that the location is correct.
Select Start, Settings, Control Panel,
and then double-tap or double-click
the Dialing icon. Make sure that the
location settings reflect your current
location, that the location’s dialing
pattern is appropriate, and that the
local country and area code are
correct.

The connection is unreliable •  Make sure the modem is firmly seated
and connected to your device and the
telephone jack.

•  Disable call waiting. Select Start,
Settings, Control Panel, and then
double-tap or double-click the Dialing
icon. Select Disable call waiting by
dialing and enter the disable code
specified by your telephone company.

Network Connection is not listed in
the ActiveSync dialog box

•  Close the dialog box, wait a few
minutes, and try again.

•  Reset the device.
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Infrared transfer between Windows CE-based devices

Problem Solution
If you are unable to use infrared to
transfer information between
Windows CE-based devices, try
the following.

•  Transfer only one file, or no more than
25 contact cards, at a time.

•  Position the infrared ports so that they
line up and are less than one meter
(three feet) but more than two inches
apart.

•  Make sure nothing is between the two
infrared ports.

•  Adjust the room lighting. Some types
of light interfere with infrared
communication. Try moving to a
different location or turning off some
lights.

Display
If you’re having trouble viewing your data, here are some suggestions.

Problem Solution
Screen is blank •  Adjust the display contrast.

•  Reset the device.
•  Charge the main battery.

System response
Sometimes the device doesn’t respond as quickly or accurately as usual. Here are
some tips to get you back up to speed.

Problem Solution
Inaccurate response to stylus taps •  Recalibrate the stylus. Press

CTRL+ALT+ + (PLUS key), or select
Start, Settings, Control Panel, and
then double-tap or double-click the
Stylus icon.

Slow or no response •  Reset the device.
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Battery

The low main battery message
appears.

•  Charge the main battery.

Continuous Operating time is
extremely short even after the main
battery is fully charged.

•  The main battery is worn out. Consult
your Sharp dealer to replace it.

The charging lamp flashes rapidly
(4 times per second).

•  Indicates a malfunction.
Consalt your Sharp dealer.
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B. Hardware specifications

CPU MIPS RISC processor
Memory 32 MB RAM*1 standard (SDRAM), 2 MB (Video RAM)
Display Resolution 7.1" color TFT LCD with backlight, non-glare, Touch

panel, 800 × 480 dot 65,536*2 colors
Keyboard 15 mm pitch (English keyboard layout)
Audio Built-in microphone / speaker (mono)
Card slots PC card (Type II) × 1, Compact Flash card (Type II) × 1
Modem*3 V.90 compliant

Data*4: 56 Kbps (receiving), 33.6 Kbps (sending),
Fax*4: 14.4 Kbps

I/O ports Serial (RS-232C)/VGA out × 1, USB × 1, IR (IrDA1.1) × 1,
RJ-11 × 1 (modem), earphone jack × 1 (16 to 40Ω)

Camera Photographic
element

1/4-type primary color RGB filter, 350,000 pixels
(310,000 pixels are effective), square pixel CMOS image
sensor

Lens Fixed focus lens F3.4 f =3.85 mm
Shutter speed Automatic (1/7 to 1/15,000 seconds)
Focus mode Fixed
Capture
distance

Approximately 26 cm to infinity

Exposure
control method

Electronic shutter control

Exposure
correction

Variable storage time method

White balance Automatic
Horizontal
resolution

300 TV lines

Power Main 10.8 V DC, Lithium-ion Rechargeable Battery Pack
19 V DC, AC adapter

Backup CR2032 lithium battery × 2
Power consumption 9.2 W (when using the battery pack)

27.7 W (when using an AC adapter)
Battery
life*5

(Operation)

Main Approx. 10 hours
(5 minutes operation and alternating 55 minutes display
only with minimum backlight, at an ambient temperature
of 25°C (77°F))

Approx. 5 hours
(exploring the Web using Pocket Internet Explorer,
connecting to internet with built-in modem*3, with
minimum backlight, at an ambient temperature of 25°C
(77°F))

Approx. 2.5 hours
(monitoring with the built-in camera with maximum
backlight, at an ambient temperature of 25°C (77°F))
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Battery
life

Main Approx. 1 month (fully charged with the power off, at an
ambient temperature of 25°C (77°F))

(Data
backup)

Backup Approx. 9 days (when the device won’t run off the battery
pack, at an ambient temperature of 25°C (77°F))
Approx. 7 days (with the battery pack removed, at an
ambient temperature of 25°C (77°F))

Battery
charging
time

Main Approx. 2.5 hours (at an ambient temperature of 25°C
(77°F))
*charging time varies depending on usage

Dimensions 213 (W) × 140 (D) [camera part 142.5] × 28.3 (H) [battery
part 31.8] mm
8.4" × 5.5" [5.6"] × 1.1" [1.3"]

Weight Approx. 860 g (1.89 lb) (including battery pack)

*1 Memory allocation for storage memory and program memory is adjustable. RAM
cannot be expanded.

*2 Differs according to the application being used.
*3 Models with a built-in modem may not be available in some countries.
*4 The execution speed for software modems is slower than that for modems that use a

PC card.
*5 Battery life will be extended if display brightness is lowered. Further, battery life may be

reduced when the device is used with a PC or CF card, used in low temperatures,
connected to a PC, or data is continually input.
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